Modelling Micromotion of Implants in the Rat Femur

A rat femoral knee prosthesis to simulate aseptic loosening

J.W. Vijverberg
1327585
Modelling Micromotion of Implants in the Rat Femur

A rat femoral knee prosthesis to simulate aseptic loosening

By

J.W. Vijverberg

in partial fulfilment of the requirements for the degree of

Master of Science
in Biomedical Engineering

at the Delft University of Technology,
to be defended publicly on Friday December 23, 2016 at 13:00

Supervisors: Dr. ir. D.H. Plettenburg
Prof. dr. ir. E.R. Valstar

Thesis committee: Dr. ir. D.H. Plettenburg
Dr. A.A. Zadpoor
Dr. ir. I. Apachitei

An electronic version of this thesis is available at http://repository.tudelft.nl/.
Abstract

**Background:** Aseptic loosening (AL) of cementless implants is causing approximately 60% of total knee and total hip arthroplasty revisions. AL is caused among other factors by micromotion. The result is that the bone around the prosthesis is replaced by a fibrous membrane. This fibrous membrane allows for more micromotion and we thus enter a vicious circle of loosening. In-vivo research for treatments of AL and research into preventing AL is rare. When in vivo research is conducted, this is commonly done in large animals such as sheep and dogs. To bring down costs and increase reproducibility it is desired to recreate the fibrous membrane in a smaller animal. Therefore, an unstable knee hemiprosthesis was designed for the femur of the Wistar rat.

**Methods:** First a test was conducted on cadaverous adult male Wistar rat femurs to assess whether it was easier to access the medullary canal of the femur from the hip or the knee side. Then, a second test was conducted on cadaverous rat femurs (n=8) to assess the depth and width to which we could implant a cylindrical prosthesis. The third set of tests was to see if the conceptual unstable prosthesis allowed micromotion of 200 µm. Miniature silicone rubber and polyurethane resin (PUR(r)) springs were tested and a mock implantation in bone surrogate was conducted.

**Results:** The results obtained from the first test show that it is easier to access the medullary canal of the femur from the knee side. The straight canal of the distal femur was also found to be more suitable to allow for micromotion than the curved canal of the proximal femur. The second test showed that we could implant a cylinder with a diameter of 2.3 mm and a length of 2.3 cm in the femoral canal. The third test showed that the conceptual prosthesis allowed for micromotion, but the spring’s material needs to be optimized. PUR(r)’s creep and compression set were too high. Silicone showed the most potential, because of its low compression set (permanent compressive deformation). However, the stiffness of the silicone needs to be increased and it showed high wear during fatigue testing with respect to the PUR(r).

**Conclusion:** The conceptual prosthesis showed promise, but improvements on the spring material are necessary. The silicone can be made stiffer and altering the design can also increase the stiffness of the prosthesis. A flaw in the conceptual design is that micromotion is restricted in vivo, because the femoral prosthesis is abutted by the distal cortical bone. A change in the design of the prosthesis can remedy this problem. Another remaining challenge is to design a prosthesis which allows for localized application of wear debris particles and treatment solutions in the peri-prosthetic tissue, fully simulating the circumstances that occur during AL.

**Keywords:** Rat; femur; implant; prosthesis; hemiprosthesis; knee hemiarthroplasty; micromotion; aseptic loosening; osteolysis; in vivo model
# Table of Contents

1 Introduction .................................................................................................................. 1
  1.1 Background ........................................................................................................... 1
  1.2 Problem Statement ............................................................................................... 2
  1.3 Setup of the Report ............................................................................................... 2

2 Problem Analysis .......................................................................................................... 3
  2.1 Functional Analysis .............................................................................................. 3
  2.2 Program of Requirements ................................................................................... 4

3 Synthesis ..................................................................................................................... 5
  3.1 How to Fixate a Prosthesis in the Femur of the Rat? ........................................... 5
  3.2 How to Allow for Micromotion? .......................................................................... 6
  3.3 How to Open the Medullary Canal? .................................................................... 6
  3.4 Design Concepts .................................................................................................. 7
    3.4.1 Spring Concept .............................................................................................. 7
    3.4.2 Rubber Spring Concept ................................................................................. 8
    3.4.3 Pressure Cylinder .......................................................................................... 9
  3.5 Concept Selection ................................................................................................. 10
    3.5.1 Harris Profile ............................................................................................... 10
    3.5.2 Concept Selection ......................................................................................... 10

4 Simulation .................................................................................................................. 11
  4.1 Opening the Medullary Canal of the Rat .............................................................. 11
    4.1.1 Accessing and Reaming the Medullary Canal ............................................. 11
    4.1.2 Sizing the Medullary Canal and Press-Fitting Stable Implants ................. 12
  4.2 Force-Displacement of the Silicone Springs ....................................................... 13
    4.2.1 Silicone Rubber - Compression .................................................................. 13
    4.2.2 Silicone Rubber - Fatigue ........................................................................... 15
  4.3 Force-Displacement of the PUR(r) Spring ........................................................... 16
    4.3.1 Polyurethane Resin - Compression .............................................................. 16
    4.3.2 Polyurethane Rubber - Fatigue ................................................................. 18
  4.4 Transversal Expansion of the Rubber Spring ....................................................... 19
  4.5 Press Fitting the Stable Prosthesis in Bone Surrogate .......................................... 20
  4.6 Micromotion of the Unstable Prosthesis in Bone Surrogate .................................. 21

5 Discussion ................................................................................................................... 24
  5.1 Properties of the Rubber Springs ........................................................................ 24
  5.2 Force-Displacement Validity .............................................................................. 24
  5.3 Fatigue Validity .................................................................................................. 24
  5.4 The Medullary Canal Model ............................................................................... 24

6 Recommendations ..................................................................................................... 24
  6.1 Implantation ....................................................................................................... 24
List of Abbreviations and Short Glossary

\(\mu\)CT – Micro computed tomography
ACL – Anterior cruciate ligament
AL – Aseptic loosening
Anterior – Towards the front side of the body [Antonym: Posterior]
AoI – Angle of inclination
CAD – Computer aided design
CFPF – Cotton filled phenol formaldehyde
CP – Calcium phosphates
CT – Computed tomography
Diaphysis – Shaft of the long bone
DMA – Dynamic mechanical analyser
Ex vivo – Using cadaverous tissue
Femur – Thigh bone
HA – Hydroxyapatite
Inferior – Towards the tail [Antonym: Superior]
In vivo – Using living animals
In vitro – Using a simulated environment
Lateral – Away from the central axis of the body [Antonym: Medial]
LUMC – Leiden University Medical Center
Medial – Towards the central axis of the body [Antonym: Lateral]
Medullary canal – The central canal of long bones
MCM – Medullary canal model
Patella – Kneecap
PBS – Phosphate buffered saline
PCL – Posterior cruciate ligament
PoR – Program of requirements
Posterior – Towards the back side of the body [Antonym: Anterior]
PUR(r) – Polyurethane resin
PWJ – Pulsatile water jet
RFP – Rat femoral prosthesis
SD – Stable design (of the prosthesis)
SLM – Selective laser melting
Superior – Towards the head [Antonym: Inferior]
Tibia – Shin bone
TJR – Total joint replacement
TKR – Total knee replacement
UD – Unstable design (of the prosthesis)
UMCU – University Medical Center Utrecht
UTM – Universal testing machine
WEDM – Wire electrical discharge machining
1 Introduction

1.1 Background

Hip and knee arthroplasty is a common procedure in which the damaged articulating surfaces of the human joint are replaced by a prosthesis. Two main fixation methods are distinguished: cemented implantation and cementless implantation. In cemented implantation, the metal prosthesis is fixed in the bone using bone cement, PMMA glue. In cementless implantation, the prosthesis is fixed through press-fitting, screws or a combination of both.

Implantation of joint prostheses in humans leads to bone resorption, also known as osteolysis. The bone in the area around the implant is slowly resorbed through biological processes in the human body, resulting in a loss of bone tissue in the direct vicinity of the implant [the periprosthetic tissue]. Focussing on cementless prosthesis, this resorption is caused by several stimuli:

1. Wear debris causes an inflammatory reaction, which activates the bone resorbing cells: the osteoclasts (Abu-Amer et al. 2007).
2. Micromotion can prevent osseointegration: bone ongrowth and ingrowth with the implant. It can also cause the integrated bone-implant interface to debond (Szmukler-Moncler et al. 1998).
3. Stress shielding happens because the stiff material of the implant absorbs the lion’s share of the applied load. Bone is resorbed when not mechanically stimulated (Bobyn et al. 1992).

The bone resorption resulting from these three stimuli leads to even more micromotion and more osteolysis [bone resorption], resulting in a positive feedback loop. When the final stage of this loosening is reached, the prosthesis is encapsulated by a fibrous membrane, formed by the patient’s own bone resorption and synthesizing cells. This fibrous membrane is very flexible compared to bone, which results in a prosthesis that is said to be aseptically loosened (AL). Osteolysis due to micromotion is induced once the micromotion reaches a certain threshold. This threshold lies somewhere between 50 to 150 μm (Jasty et al. 1997; Szmukler-Moncler et al. 1998). When the micromotion is lower than this threshold, bone can integrate with the prosthesis, which results in solid fixation between the prosthesis and the bone. When the micromotion is higher than this threshold, bone cannot integrate with the prosthesis surface, which results in the positive feedback loop.

About 12% of primary hip and knee implants are revised after 10 years (Labek et al. 2011). In Europe, aseptic loosening causes about 60% of these revisions (MacInnes et al. 2012; Garellick et al. 2013). The standard revision method for loosened hip and knee implants is to replace them with a new implant. However, revision surgery is a very invasive and costly procedure. Therefore, there is a need to research therapeutic interventions to either prevent aseptic loosening completely or to treat the loosening without replacing the primary implant.

A strategy to prevent aseptic loosening is by inhibiting the inflammatory reaction caused by the wear particles and consequently inhibit the resorption of the periprosthetic bone (Goodman et al. 2014). Strategies to treat aseptic loosening are application of biological factors, gene therapy and/or bone substitutes (Oryan et al. 2014).

Advances and approvals of new treatment methods rely on in vivo models of bone defects. A problem with in vivo research is that a lot of laboratory animals are needed to generate the required statistical power. These test animals are expensive and the costs are heightened even further due to the fact that it is common to test implants on large animals such as dogs, goats and sheep. The reason to opt for larger animals is often a practical one: there is simply more volume available for implantation.

This thesis researches the possibility to produce a cementless rat femoral prosthesis (RFP) to simulate aseptically loosened implants in humans. Even though the available volume is very limited in the rat femur and there are animals that have bone growth and bone composition that is more similar to humans (Aerssens et al. 1998), there are several (key) advantages to using rats as a model system:

- It is a highly reproducible and a “well characterized [...] model for preliminary screenings of new pharmacological agents or therapeutic modalities” (Aerssens et al. 1998)
- Micro CT [μCT] can be used to image the bone growth of anesthetized rats. The resolution of μCT (=40 μm) allows imaging of the bone structure.
- A rat model is inexpensive compared to larger animal models
- The generic rat model can facilitate comparisons between studies
1.2 Problem Statement

The goal of this research is to develop a prosthesis for rats that can induce aseptic loosening. With the prosthesis, we can test new methods to prevent or treat aseptic loosening.

1.3 Setup of the Report

The report and design of the implant is guided by following the steps of the basic design cycle, as defined by (Roozenburg & Eekels 1995) [Figure 1].

The problem analysis, described in Section 2, results in a list of design criteria. The Program of Requirements (PoR). From the PoR we have synthesized a provisional design. as described in Section 3.

The simulation covers the experiments that are conducted to come to a provisional design. It is discussed in Section 4 along with its expected properties. In Section 5, the discussion, we evaluate the value of the design.

From this evaluation, recommendations are made for future work in Section 6.

Finally, in Section 7, the most important findings are summarized in the conclusion, and the decision whether or not to follow up on this research is explained.

Figure 1: The basic design cycle (Roozenburg & Eekels 1995)
2 Problem Analysis

In this section, the design challenge is formulated. Solutions to the design challenge are formulated in Section 3.

When conducting research in general, it is necessary to verify the results against a control group. Therefore, we want to create two implants: a stable and an unstable design [Figure 2]. The stable design serves as the control group and can be implanted in the opposite femur; the unstable design needs to generate a fibrous membrane in rats similar to the aseptically loosened fibrous membrane occurring humans.

![Figure 2: Stable versus the unstable design principle of the RFP](image)

It must be noted that at the outset, we do not know how the fibrous membrane will develop in vivo. Furthermore, it is uncertain if the unstable implant can induce a fibrous membrane in a way that is similar to the human aseptically loosened fibrous tissue.

2.1 Functional Analysis

To create an overview of the design problems, we analyse the functions that need to be fulfilled by the implant.

We want to develop an RFP that can be implanted and for which the fixation can be assessed in vivo. The use phases of the implant are identified below and summarized in Figure 3.

1. The bone size of the femur is obtained. This can be done by e.g. weighing the rat and estimating the femur size based on the weight, or by scanning the joint using µCT and extracting the femur size from the scans.
2. The RFP is sized.
   From the bone model, the space that is available for implantation is extracted and the RFP is sized accordingly. Step 1 & 2 might be redundant if implants with a standard size can be used.
3. The RFP is produced. Production techniques that are available in-house are metal printing [Selective Laser Melting, SLM], wire electrical discharge machining [WEDM] and classical machining techniques like turning and milling.
4. The RFP is prepared for implantation. Before implantation, the RFP must be sterilized and coatings can be applied if necessary.
5. The femoral canal is opened. When needed, the medullary canal is dimensioned to fit the RFP. Debridement of the medullary canal is possible by rinsing the canal with a sterile saline solution.
6. The RFP is implanted. The shape of the cementless prosthesis should allow for easy implantation and slightly oversizing the diameter of the prosthesis allows for a press-fit fixation of the prosthesis within the bone.
7. The fixation of the RFP is assessed in vivo. This is needed to measure the effects of the varying treatment methods. Note that we assume that the fixation can be measured by radiographs or µCT. Therefore, this step lies outside the scope of this project.

---

1 The medullary canal is the canal with bone marrow inside long bones. In our case the medullary canal of the femur.

---

1. Obtain Bone Size
2. Size RFP
3. Produce RFP
4. Prepare RFP
5. Open Femoral Canal
6. Implant RFP
7. Assess Fixation

Figure 3: Functional Analysis of a cementless rat femoral prosthesis (RFP). The blue stepping stones lie within the design scope of this project.
2.2 Program of Requirements

The Program of Requirements (PoR) is derived from the Functional Analysis. The numbering used in the PoR corresponds with the numbering of the Functional Analysis (Figure 3). If we want to prove the feasibility of an RFP, it is required to:

1. Conceive a standardized way to create a 3D model from the µCT scans of rat femora.
   ✷ Rat femora from adult male Wistar rats are available. They can be scanned using µCT at a resolution of 20 µm.
   ✷ From the µCT images the bone and the implantable region need to be segmented.
   Once segmented, a 3D model is generated.

2.1 Size a RFP that can simulate the stable cementless fixation.
   ✷ This implant must be fully fixated in the rat femur. The design of this fixated implant is designated as the stable design (SD).
   ✷ The SD must allow for micromotion lower than 40 µm (Jasty et al. 1997; Szmukler-Moncler et al. 1998).
   ✷ The SD must allow for fluid biologics to be applied in the periprosthetic region. [This requirement lies outside the scope of this report]
   ✷ The SD must allow for polyethylene particles to be applied in the periprosthetic region. [This requirement lies outside the scope of this report]

2.2 Size a RFP that can simulate the aseptically loosened cementless fixation.
   ✷ This implant must be unstably fixated in the rat femur. The design of this loosely fixated implant is designated as the unstable design (UD).
   ✷ The UD must allow for micromotion of 200 µm (Jasty et al. 1997; Szmukler-Moncler et al. 1998) along the femoral axis.
   ✷ The micromotion of the UD must be unhindered by fluid, particles or tissue.
   ✷ The UD must allow for fluid biologics to be applied in the periprosthetic region. [This requirement lies outside the scope of this report]
   ✷ The UD must allow for polyethylene particles to be applied in the periprosthetic region (0.3 up to 10 µm) (Green et al. 1998). This is necessary to simulate activation of the immune system by wear particles. [This requirement lies outside the scope of this report]

3. Produce the two types of femoral stems.
   ✷ The implants can be produced in the titanium alloys Ti-6Al-4V and Ti-6Al-7Nb. These are the common alloys used for cementless implants. The first choice is to machine the implants through readily available machining methods. Otherwise, selective laser melting (SLM) is available with a dimensional error of approximately 40 µm for 2 cm large implants (Campanelli et al. 2014).
   ✷ The choice for 3D printing could allow for some specific design options. When designed properly, it might be possible to include internal channels in the prosthesis. This could simplify the application of fluids and particles. [This requirement lies outside the scope of this report]
   ✷ The accuracy of the production method needs to be high enough for properly fitting the implant in the bone.

4. Prepare the RFP for implantation.
   ✷ The prosthesis must be produced in a material that can be easily sterilized. Moreover, it must be possible to coat the prosthesis with calcium phosphate (CP). This type of coating is often used to enhance the fixation of prostheses within the bone. The alloys Ti-6Al-4V and Ti-6Al-7Nb allow for sterilization and CP coating.

5. Open the medullary canal of the rat femur for implantation.
   ✷ Before we can implant the RFP, it is necessary to access the medullary canal. We need to conceive a method with either standard bone rasps, drills and/or osteotomes. If these do not suffice a rat specific tool needs to be designed and produced.
   ✷ We want to maintain 400 µm of cortical bone, when reaming of the medullary canal is necessary (Appendix E).

6. Implant the RFP in the femoral canal of a rat.
   ✷ Because the implant is inserted into a cavity, the cross section must be constantly diminishing with respect to the centre line.
   ✷ The centre line is straight or a circle arc with a set radius to guarantee implantability.

7. Assess the micromotion of the RFP in vivo.
   ✷ Varying treatments will be tested with the RFP. The effects of the treatments need to be assessed. We assume that it is possible to measure bone remodelling and the potential micromotion with radiographs or µCT (Kinney et al. 1995). Furthermore, the bone ingrowth and bone-to-implant contact can be measured from histological slices and/or µCT images.
3 Synthesis

In this section the conceptual solutions are formed. Finally, the most feasible concept is selected. To do this, we selected the principal design problems from the PoR (Section 2.2). Five principal design problems are identified:

1. How to fixate an RFP with less than 40 µm of motion, simulating a solid cementless fixation? (PoR 2.1 & 6)
2. How to simulate the micromotion that occurs when a cementless prosthesis is aseptically loosened? (PoR 2.2 & 6)
3. How to open the medullary canal of the rat femur? (PoR S)
4. Where and how can we introduce wear products into the in vivo model? (PoR 2.1 & 2.2)
5. Where and how can we introduce biologics into the in vivo model? (PoR 2.1 & 2.2)

The scope of the project is limited to the first three principal problems. This was done because the first three problems are crucial to proving that an aseptically loosened prosthesis can be implanted in the rat femur, while principal problems 4 and 5 complicate the proof of principle.

For the first three problems, principal solutions were generated during an ideation session. This resulted in the ideas put forth in Section 3.1 up to 3.3 and the design concepts in Section 3.4.

3.1 How to Fixate a Prosthesis in the Femur of the Rat?

Cementless fixation in the medullary canal is reduced to press-fitting an implant or screwing an implant in the bone. Because the cortical bone in the rat femur is extremely thin, we opted for press-fitting implants for fixation.

However, by which percentage to oversize an implant such that it can be press-fitted in the medullary canal is difficult to tell. An experiment was conducted to find out the maximum allowable diameter of the implant (Section 4.1).
3.2 How to Allow for Micromotion?

First of all, to allow for micromotion we need to know the force that will be put on the implant. The supplied Wistar rats were weighed before the femurs were excised and the body weight was approximately 400 g. Inverse-dynamics of the rat gait pattern estimated that the proximal part of the rat femur is loaded in excess of 500% of the body weight and the distal part of the femur in excess of 600% of the bodyweight (Wehner et al. 2010).

Consequently, we can calculate the maximum force that is put on the implant during gait:

\[ 400 \text{ g} \times 600\% = 2400 \text{ g} \quad \text{and} \quad 2400 \text{ g} \approx 23.5 \text{ N} \]

Secondly, we need to take into consideration that there will always be a minimum force on the implant. This is because of the joint capsule and the tendons that lie across the joint, which apply a constant force on the articular surfaces. The implant must resist this force with some sort of pretension, because otherwise the implant will be in a constantly compressed state.

Thirdly, we must take into consideration that it is estimated that the normal gait pattern of a rat already introduces a strain of 258 µm/m in the cortical bone (Wehner et al. 2010). Assuming that the implanted prosthesis will be approximately 2 cm long, this will induce a micromotion of approximately \( 2/100 \times 258 \approx 5.2 \text{ µm} \) over the length of the implant. We neglect this strain, but this might cause an error of approximately \( 5.2/200 \text{ µm} \approx 2.6\% \) in the in vivo measurements.

In short: we want to be able to apply pretension on the micromotion concept; at 23.5 N the deflection must be 200 µm; natural bone strain is neglected. In the ideation three viable micromotion concepts were generated, they are discussed further in Section 3.4.

3.3 How to Open the Medullary Canal?

Implant Shape

Similar to a human femoral stem, we want to access the bone canal of the rat femur from either the superior (hip) side or the inferior (knee) side. The shape of the rat femur leaves us with only a couple of implantation options.

When opening the medullary canal from the hip, there are two options where we can place saw cuts (Figure 5). Just below the femoral head or as close to the greater trochanter and lesser trochanter as possible. Because the canal of the femoral neck has a lower diameter, we want to place the saw cut as close to the greater and lesser trochanter as possible [Figure 5]. A hip prosthesis will have to replace the femoral head and neck and needs to be fixated in the medullary canal. A rat hip prosthesis will likely be similar in form to femoral stems for humans.

When opening the medullary canal from the knee, we need to consider that we severely damage the femoral-patella joint. To counteract this, we need to insert a prosthesis that replaces the articular cartilage on the femoral side of the knee joint. We therefore believe that the best position to place the saw cut is to cut just above the articular cartilage of the patellar groove.

Ex vivo tests will be conducted (Section 4.1), from this it is concluded that access from the knee joint is the most feasible option for a prosthesis that needs to loosen.

Figure 5: LEFT: Section A-A of the rat femur with locations for saw cuts. RIGHT: Section B-B of the rat femur.
3.4 Design Concepts

The three concepts allowing for micromotion are elaborated: the spring, rubber spring and compressible liquid concepts. To calculate the amount of space that is required for each micromotion concept, CAD models where drawn out. Keep in mind that the bottom part of all the concepts will be press-fitted into the bone. The top part of the prostheses is required to allow for the set micromotion. The outer diameter of the concepts is constrained to a maximum of 2.50 mm to fit the medullary canal.

3.4.1 Spring Concept

The most obvious way to allow for micromotion is to use a compressive spring. Pretension on the spring is required, because we want the implant to return to its original form. Moreover, we know that:

- We have a maximum force of 23.5 N per implant
- We design the spring with a pretension of 50% (11.75 N)
- We want to obtain a micromotion of 200 µm

Then we need a spring constant of:

\[ C = \frac{F}{\Delta L} = \frac{23.5 - 11.75}{0.2} \approx 59 \text{ N/mm} \]

However, a spring constant of 59 N/mm is about 6 times higher than what is possible with miniature springs that were available from stock in the permissible size (hole diameter ≈ 1.5 mm) (Lee Spring 2016).

A specialized spring design might have such a high spring constant [Figure 6]. The working travel of the spring is low, but suitable for this application: \( L_C - L_0 = 0.45 \text{ mm} \).

Applying a pretension of 11.75 N to the spring would leave ≈215 µm of motion for the implant within the bone.

However, after consideration with a design expert, the index of the spring appeared to be too low:

\[ \text{index} = \frac{D_{\text{mean}}}{d} = \frac{(D_e - d)}{d} \approx 3.13 \]

A low index spring is coiled too tight and is prone to collapse and fatigue failure. And because it was not possible to increase the diameter of the spring, the spring concept (Section 3.4.1) was rejected.

CAD Model of the Spring Concept

The classical spring concept is drawn out in Figure 7 and 8. The spring is pretensioned with a solid plastic cylinder (in white), that is interlocked with a transversal peg. The pretension might be adjusted by inserting a different shaped peg. The transversal peg also prevents rotation of the top part of the prosthesis with respect to the bottom part.

When a wall radius of 0.25 mm is selected, there is space for a spring with a diameter of 2.00 mm. As discussed above, a spring with a diameter of 2.00 mm would not be able to withstand the predicted load.
3.4.2 Rubber Spring Concept

The second option is to choose for a highly flexible material to act as spring. The cross-section of the implant in the distal femur is approximately an ellipsoid with major and minor axis of 3.2 mm by 2.2 mm respectively. In this ellipsoid, a circular spring with a maximum outer diameter of 2.2 mm and an inner diameter of 1.1 mm was fitted (Figure 9). The inner hole is required for pretensioning the spring with a hammer. This hole is fixed to a minimum of 1 mm.

The compressible area of the spring is:

$$\pi \times (2.2^2 - 1.1^2) = 11.4 \text{ mm}^2$$

And the stress on such a disk would be:

$$\frac{23.5 \text{ N}}{11.4 \text{ mm}^2} = 2.06 \text{ MPa}$$

If we would then choose to use a disk with a height of 2 mm of this material and want to obtain a pretension of 200 µm and an extra micromotion of 200 µm, we would require $$\epsilon = 0.4/2 \times 100 = 20\%$$ of strain. Assuming strain is linearly proportional to the stress on the disk, we need a material with an elastic modulus of:

$$E = \frac{\sigma}{\epsilon} = \frac{2.06 \times 10^6}{0.20} = 10.3 \text{ MPa}$$

Some of the medical silicone rubbers [from here on referred to as silicones] are known to have elastic moduli in this range. However, rubber does not have a linear stress-strain relationship.

CAD Model of the Rubber Spring Concept

The rubber spring concept is drawn out in Figure 10 and 11. The spring is pretensioned with a hammer that runs through the spring and interlocks with the bottom part of the implant. The pretension might be adjusted by inserting a hammer with a different length. The cross-section of the bottom part of the hammer has the form of a cut-off circle (Figure 12). The form fixation of the hammer within the prosthesis prevents rotation of the top part of the prosthesis with respect to the bottom part. Moreover, it imposes a maximum on the micromotion by running into the bottom cap after 200 µm.
3.4.3 Pressure Cylinder

The third option was to use a cylinder with a compressible fluid or gas to withstand the forces in the femur.

![Figure 13: The forces and pressures in a rod and cylinder model, copied from (The Engineering Toolbox 2015)](image)

To withstand the piston force $F_1$ of 23.5 N, the opposite force $F_2$ must be equal to the piston force. The pressure in the cylinder ($P_2$) must therefore be equal to:

$$F_1 = F_2 = \frac{\pi}{4} \cdot d_2^2 \cdot P_2$$

$$P_2 = \frac{F_1 \cdot 4}{\pi \cdot d_2^2}$$

Assuming $d_2 = 1.60 \text{ mm}$, and the force on the left side of the cylinder is equal to 23.5 N, the cylinder needs to be pressurized up to:

$$\frac{23.5 \cdot 4}{\pi \cdot 0.0016^2} = 11.7 \text{ MPa} = 117 \text{ bar}$$

The smallest ready-made check valve that we could find has a diameter of 3.2 mm and can resist 100 bar (Cambridge Reactor Design 2010). This diameter and pressure rating do not suit the design requirements, they are too large and too small respectively. Therefore, the compressible liquid concept was rejected.

**CAD Model of the Compressible Liquid Concept**

The compressible liquid concept is drawn out in Figure 14 and 15. The pretension is applied by the existing pressure in the chamber. The pretension can easily be adjusted by altering the pressure in the chamber. The shape of the piston rod prevents rotational movement of the implant [Figure 16].
3.5 Concept Selection

3.5.1 Harris Profile

From the design concepts in Section 3.4, the most viable design is chosen based upon a set of criteria. The criteria and their score for the three different concepts is illustrated graphically in the Harris Profile below (Table 1). Each criterion is discussed in its corresponding paragraph. Every concept is graded from excellent (two bars of green), good, mediocre to poor (two bars of red).

Producibility

The producibility is an estimation of the chance that the concept can be produced successfully. The producibility of the rubber spring concept is considered to be [good], even though moulding of the miniature springs could cause some problems with the entrapment of air bubbles.

The spring in the spring concept is difficult to produce and can cause problems because of the small size. [mediocre] Producing the pressure concept is nearly impossible, because of the high demands placed on a tailor-made check valve. [poor]

Space Requirements

The space requirement is simply a measure for whether it can fit in the medullary canal or not. The space requirements for both the spring was a bit too high, with a 4 mm medullary canal we would probably have been able to resist the joint forces [mediocre]. For the pressure concept the space is very problematic due to the check valve [poor]. The rubber concept can fit within the medullary canal [good].

Tweakable Pretension

Tweaking the pretension can make it easier to alter the implant to the required specifications. Tweaking the pretension of the spring and rubber concepts is a bit more difficult than the pressure concept. The pressure concept’s cylinder pressure can easily be altered [excellent]. The spring and the rubber concept have predefined stiffness and the pretension could only be altered by producing a new spring or rubber [good].

Torsional Stability

In vivo, torsional movement is undesired and therefore it is required to resist torsional forces. All concepts can resist these forces due to a type of form fixation. Therefore, they are all graded as [good].

Debris Protection

Allowing for micromotion of the implant also introduces the problem that fluid, particles and tissue can move into the cavities of the implant. We need to prevent this, because the debris might obstruct the motion. The rubber concept inherently prevents particles from accessing the cavity of the implant, because the rubber blocks the cavity [good]. The spring and pressure concept do not include any form of protection against debris entering the cavity and are consequently scored as [mediocre] on debris protection.

![Figure 17: Problematic area where debris can block micromotion of the prosthesis](image)

Fatigue Resistance

The fatigue resistance is measuring how well the concept should be able to withstand the cyclical loading imposed by the movement of the rat. Springs and pressure cylinders can withstand cyclical loading very well, if they are used within their load range [good]. The fatigue of the rubber concept is unknown, due to the small dimensions of the spring [mediocre].

3.5.2 Concept Selection

From the Harris Profile, we can conclude that the Rubber Concept is the most viable concept. Especially the producibility of the Rubber Concept is decisive for the selection. The caveat lies within the fact that the compressive behaviour of such a spring is unknown. Therefore, compression (Section 4.2.1 and 4.3.1) and fatigue tests (Section 4.2.2 and 4.3.2) are run.

![Table 1: Harris profile showing the grading of the concepts based on the different criteria.](table_image)
4 Simulation

In the simulation section, the results from all the tests are presented. To create an implant that will properly fit the medullary canal, we need to know how to gain access to the medullary canal and how we can press-fit an implant in the medullary canal. [Section 4.1]

To create an implant with the required micromotion, as described in Section 3.4.1, the stiffness of the rubber spring needs to be clear. Therefore, tests are run to obtain the force-displacement relationships and the fatigue behaviour of the springs. Two rubber like materials are tested, silicone and polyurethane resin [PUR(r)]. [Section 4.2 & 4.3]

A quick measurement on the lateral expansion of the spring is also conducted to make sure that the RFP can be fitted in the medullary canal. [Section 4.4]

Finally, a mock implantation of the unstable RFP is carried out in a bone surrogate and the amount of micromotion is measured [Section 4.5].

4.1 Opening the Medullary Canal of the Rat

To get an idea of the surgical technique that will be required to implant the RFP two experiments are conducted on cadaverous rat femur. First off, we conducted an experiment to check if it was easier to access the femoral canal from the inferior or superior side [Section 4.1.1]. Secondly, we measured up to what diameter the medullary canal could be reamed open [Section 4.1.2].

4.1.1 Accessing and Reaming the Medullary Canal

There are two possibilities to get access to the medullary canal of the rat femur. From the superior side (the hip) or the inferior side (the knee). After getting access to the medullary canal, we want to know how to remove the bone marrow from the canal. For this, drilling and pulsatile water jet [PWJ] removal are both investigated. Drilling was done by hand using a pin vice. The PWJ was manually applied using a curved tip syringe [type: Monoject 412]. The full test protocol can be found in Appendix A.1.

Access to the canal from the superior side was difficult. Two saw thicknesses were tested for cutting off the femoral head, the 100 µm thick saw blade was too flexible [type: Tamiya # 74097], while the 150 µm thick saw was barely stiff enough [type: Tamiya #71405]. After the femoral head was cut off, access to the medullary canal could be gained through the leftover of the femoral neck. The diameter through this leftover was very small ≈ 1.25 mm [Figure 18]. Moreover, it was not possible to drill to an appropriate depth: ≈ 1 cm with a 2.0 mm drill [Figure 19]. This might be solved by sawing of more bone, but it is thought that removing more bone than the femoral head and neck can lead to problems in the rat’s gait.

Figure 18: Rat femur with the femoral head sawn off

Figure 19: Medullary canal opened with a 2.0 mm drill [Superior approach]

Figure 20: Rat femur with the condyles sawn off
Access from the inferior side was relatively easy. After the condyles of the knee were sawed off using the 150 µm saw (Figure 20), it was very easy to drill into the medullary canal. In this initial test, the drill depth and diameter were 2.0 cm and 2.0 mm respectively.

The PWJ was tested for both the superior and inferior approach. Applying the PWJ was done in a water bath to prevent forming aerosols. For the superior approach, it was cumbersome to place the syringe on the femoral neck. On the other hand, it was relatively easy to apply the PWJ when using the inferior approach. This, because the larger opening at the knee side of the femur aided in placing the syringe, which makes it easier to inject and withdraw the fluid.

The problem with a PWJ lies within the fact that it is not possible to control where the marrow and adipose tissue is being removed. As a result, most of the medullary canal was empty after PWJ from the superior side and the medullary canal was completely empty using PWJ from the inferior side (Figure 21). Removing all the marrow is thought to be unnecessarily damaging to the health of the rat.

In short, we opted for an inferior approach and using standard drills.

4.1.2 Sizing the Medullary Canal and Press-Fitting Stable Implants

In this second test, drills with increasing diameter are used to drill open the medullary canal from the knee side. The femurs from four rats are used [n=8]. After the canal is opened to its maximum size, smooth stainless steel cylinders with increasing diameter (2.35, 2.40, 2.45 and 2.50 mm) are fitted in the medullary canal. This gives an approximation of the amount of oversizing required for press-fitting.

The test results can be found in Table 2. Two breaks occurred on the proximal anterior lateral side of the femur (Figure 22). One break occurred during a drill with a ᴜ 2.3 mm and one with a drill of ᴜ 2.4 mm. These both happened at large drill depths: 3.0 cm and 2.5 cm respectively.

Next to that, two full breakages of the femur happened when using a drill of ᴜ 2.5 mm: the femur split open on both the medial and lateral side of the diaphysis.

What we might prudently conclude is that drilling in the medullary canal with a diameter of 2.3 mm up to a drill depth of ≈2.3 cm is well tolerated by the femurs.

![Figure 21: Medullary canal opened with water pressure. The cut through the shaft revealed that the medullary canal was completely empty. (Inferior approach)](image)

![Figure 22: Posterior anterior lateral break of the rat femur.](image)

<table>
<thead>
<tr>
<th>Femur</th>
<th>Rat weight</th>
<th>ᴜ 2.1 mm</th>
<th>ᴜ 2.2 mm</th>
<th>ᴜ 2.3 mm</th>
<th>ᴜ 2.4 mm</th>
<th>ᴜ 2.5 mm</th>
<th>Press-Fit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Right</td>
<td>412 g</td>
<td>EoD</td>
<td>3.1 cm EoD</td>
<td>2.9 cm</td>
<td>2.2 cm</td>
<td>2.2 cm</td>
<td>2.45 mm</td>
</tr>
<tr>
<td>1 Left</td>
<td>&quot;</td>
<td>EoD</td>
<td>2.8 cm</td>
<td>2.6 cm</td>
<td>2.6 cm</td>
<td>2.6 cm; Full</td>
<td>NaN</td>
</tr>
<tr>
<td>2 Right</td>
<td>413 g</td>
<td>EoD</td>
<td>2.9 cm</td>
<td>3.0 cm; EoD; PAL</td>
<td>2.9 cm</td>
<td>2.8 cm</td>
<td>2.45-2.50 mm</td>
</tr>
<tr>
<td>2 Left</td>
<td>&quot;</td>
<td>EoD</td>
<td>2.4 cm</td>
<td>2.2 cm</td>
<td>2.2 cm</td>
<td>1.7 cm</td>
<td>2.45 mm</td>
</tr>
<tr>
<td>3 Right</td>
<td>426 g</td>
<td>EoD</td>
<td>2.7 cm</td>
<td>2.6 cm</td>
<td>2.6 cm</td>
<td>2.3 cm</td>
<td>2.45 mm</td>
</tr>
<tr>
<td>3 Left</td>
<td>&quot;</td>
<td>EoD</td>
<td>2.8 cm</td>
<td>2.6 cm</td>
<td>2.5 cm; PAL</td>
<td>2.5 cm</td>
<td>2.45 mm</td>
</tr>
<tr>
<td>4 Right</td>
<td>494 g</td>
<td>EoD</td>
<td>2.6 cm</td>
<td>2.3 cm</td>
<td>2.3 cm</td>
<td>2.2 cm; Full</td>
<td>NaN</td>
</tr>
<tr>
<td>4 Left</td>
<td>&quot;</td>
<td>EoD</td>
<td>2.6 cm</td>
<td>2.3 cm</td>
<td>2.2 cm</td>
<td>2.1 cm</td>
<td>2.45 mm</td>
</tr>
</tbody>
</table>
4.2 Force-Displacement of the Silicone Springs

The first set of springs are produced from silicone rubber. This elastomer was chosen, because the required (linear) compressive modulus for the rubber is 10.3 MPa (Section 3.4.2). Silicones approximately have this modulus (Granta Design Limited 2016). Moreover, they have a good compression set resistance and relatively good fatigue strength and they are readily available as prototyping material.

Three different types of silicone are tested. The hardness of the silicone rubbers varies:
- Smooth-On Dragon Skin 20 (Shore 30A)
- Dow Corning Silastic MDX4-4220 (Shore 60A)
- Dow Corning Sylgard 186 (Shore 70A)

The hardness of rubber materials is commonly measured with a durometer, which measures the materials resistance versus indentation. There are different test methods that result in varying durometer hardness scales. The two most commonly used are Shore A (for softer rubbers like silicones) and Shore D (for semi-rigid to rigid rubbers and plastics like PUR(r)).

The silicone springs were moulded at the developmental production unit of the LUMC (Leiden University Medical Center). The hardness differs from the specifications that are found in the data sheets of the suppliers, because colorants are added to the rubbers to stiffen and distinguish them. The hardness of the silicones was tested in previous production runs by the production unit of the LUMC.

The rubber springs had some variation in their dimensioning. They were produced with a height of 1.8 mm, an inner diameter of 1.0 mm, and outer diameter of 1.8, 2.0 and 2.2 mm (Figure 9). All springs were digitally measured under a microscope. The measurements can be found in Appendix A.1.

4.2.1 Silicone Rubber - Compression

The compression tests are performed on an Instron E10000 dynamic mechanical analyser (DMA) under two different conditions:
- With the inner diameter unconstrained: between two pressure plates.
- With the inner diameter constrained [Figure 23]: over a piston rod and between two pressure plates

Constraining the inner diameter was done to mimic the behaviour of the spring in the RFP. However, some springs were measured unconstrained, because the first constrained tests showed relatively large wear of the springs.

![Figure 23: Silicone spring (red) placed over the piston rod to constrain the inner diameter.](image)

The springs were compressed 1 mm (from ∼1.8 to 0.8 mm) at 0.4 mm/s and decompressed at 0.1 mm/s. Thus, 2.5 s after the start of the test, the compression was at its maximum (∼44% of original length). Typical results for the force-displacement curve can be found on the next page for both the unconstrained [Figure 24] and the constrained [Figure 25] condition. The maximum compressive force is displayed with a red marker. What can clearly be seen is that the required force for compression is increased when the inner diameter is constrained. Also, the forces were much lower than expected. Even for the stiffest spring, with the largest diameter, the force is approximately ten times smaller than what was hoped for: 10 N of force at 200 µm of pretension and 20 N at the maximum displacement of 400 µm.

Refer to 0 for the individual force-displacement curves of the different springs.
Presented below is the overview figure of the maximum compressive force per silicone spring.

**Figure 24:** Compression without rod. Sample diameter = 2.19 mm; Shore 70A Standard deviation over n=5 repetitions.

**Figure 25:** Compression with rod. Sample diameter = 2.17 mm; Shore 70A standard deviation over n=6 repetitions.

**Figure 26:** Maximum force (±SD) that was needed to compress the Shore 30A, 60A and 70A silicone rubber 1 mm.  
●-marker: test with inner diameter constraining rod; ○-marker: without rod  
Yellow/blue/red marker: before fatigue testing; black marker: after fatigue testing
4.2.2 Silicone Rubber – Fatigue

Next to the compressive behaviour, the fatigue resistance of the springs is measured. The tests are performed on an Instron E10000 dynamic mechanical analyser [DMA]. Identically to the compressive experiments, the tests are performed under two different conditions:

- With the inner diameter unconstrained: between two pressure plates.
- With the inner diameter constrained [Figure 23]: over a piston rod and between two pressure plates

First, the springs are compressed to 0.3 mm. Subsequently, a sinusoidal displacement with an amplitude of 0.1 mm is imposed on the spring at 15 Hz. The result is a micromotion starting at 200 µm up to 400 µm compression. It is estimated that the RFP needs to resist approximately 225000 load cycles [Appendix A.3]. To be on the safe side, 1*10^6 load cycles are executed.

One strain-controlled fatigue curve is shown for the unconstrained test condition [Figure 27] and one for the constrained [Figure 28]. What can clearly be seen is that the fatigue test that is run unconstrained (without a rod) eventually goes to a steady state. This was also observed with the Shore 30A and 60A samples [shown in Appendix A.4]. On the other hand, the constrained test shows larger variations in both the minimum and maximum force; a larger difference between the minimum and maximum force and a relatively steep increase in both the minimum and maximum force in the first 1*10^5 cycles. When using the pressure plates with the inner diameter constraining rod, forces around ±0.2 N were measured by the DMA when the sinusoidal movement was applied without a sample in place. Together with the fact that constraining the inner diameter made the springs stiffer, this explains partly why the difference between the minimum and maximum force is larger for the constrained case than for the unconstrained.

The sliding of the rod within the spring caused wear. After the fatigue test was finished, miniscule wear particles were found on top of the spring, on top of the constraining rod and in the hole of the upper pressure plate that was there to accommodate for the constraining rod. The steep increase of force in the first 1*10^5 cycles might be explained by the formation of the wear particles, because of the sudden increase in frictional forces. After the 1*10^5 cycles, the wear might cause the minor increase of force that occurs between 1*10^5 and 2*10^5 cycles. Moreover, this also partly explains why the difference between the minimum and maximum force is larger for the constrained case than for the unconstrained.

It was also surprising to see tensile forces in a fatigue test with compressive displacements. One reason can be the wear particles that were stuck between the rod and the upper pressure plate, causing an increase in the frictional forces, both positive and negative.

What we can conclude is that the silicone might be suitable to be used as a spring material if the stiffness can be increased. The compressive behaviour showed a continuous line on which a pretension and final load can be engineered. The fatigue behaviour looks very good, a stable minimum and maximum cycle load and no material failures were recorded. Abrasion might be a problem, preventing contact between the spring and the contact rod and between the spring and the hole in the pressure plate might solve most of the problems.
4.3 Force-Displacement of the PUR(r) Spring

Because the silicone rubber was too compliant, polyurethane resin springs are produced. Note that there is a difference between polyurethane resins and polyurethane rubbers. The resins are semi-rigid plastics, with hardness ranging from Shore 45 D to 85 D and a reported elongation at break ranging from 1 to 100% (Smooth-On 2016a; Smooth-On 2016b). The polyurethane rubber is an elastomer, with hardness ranging from Shore 10 A to 90 A and an elongation at break of 500% (Smooth-On 2010).

PUR(r) tubing was moulded at the developmental production unit of the LUMC. The PUR(r) tubing was cut into spring with a custom-made tool using a scalpel and a lathe. The springs were cut to 1.6, 1.8 and 2.0 mm height. The inner and outer diameter is the same for all springs: 1.1 and 2.2 mm respectively [Figure 29]. All springs were digitally measured under a microscope. The measurements can be found in Appendix A.2.

The inner diameter of 1.1 mm is imposed by the current design concept. The outer diameter is the maximum that can fit in the medullary canal of the rat [Section 4.1.2], producing the largest surface area for resisting compressive forces. The three different types of springs were produced to assess the effect of varying the height of the spring and (indirectly) the amount of strain. Minimizing the height of the spring is essential to maximizing the implantable area of the RFP.

4.3.1 Polyurethane Resin – Compression

The experiments are conducted on two different polyurethane resins [PUR(r)]:
- Smooth Cast 45D (Shore 45D)
- Smooth Cast 60D (Shore 60D)

The hardness of the PUR(r) was not measured to check the specifications from the manufacturer.

All compression tests are performed with the inner diameter constrained over a rod and in between two pressure plates [Figure 23]. The springs were compressed to 1 mm at 0.4 mm/s and decompressed at 0.1 mm/s. Thus, at 2.5 s the compression was at its maximum. Because the compression is absolute, the strain is varying with spring height. The 1.6 mm spring were compressed to ≈63% strain; the 1.8 mm spring to ≈56% strain and the 2.0 mm spring to ≈50% strain. For the full test protocol, refer to Appendix A.3.

Presented on the next page are two typical force-displacement curves: for a 1.6 mm spring [Figure 30] and for a 2.0 mm spring [Figure 31]. The maximum compressive force is displayed with a red marker. For the results of all the different PUR(r) springs, refer to Appendix A.5.

The standard deviations for the maximum absolute forces are large when compared to the silicone rubber springs. This is due to the fact that the compressive force required to compress the spring is decreasing over the repetitions. In turn, this is a caused by the PUR(r) spring’s very slow return to their uncompressed height. In other words, the compression set resistance of PUR(r) is too low.
Figure 30: Compression with rod.
Sample diameter = 2.25 mm;
Height = 1.63 mm. Standard deviation over n=5 repetitions

Figure 31: Compression with rod.
Sample diameter = 2.16 mm;
Height = 2.02 mm. Standard deviation over n=5 repetitions

Result Overview
Presented below is the overview figure of the maximum compressive force per PUR(r) spring.

Figure 32: Maximum force (±SD) that was needed to compress the Shore 45D and 60D PUR(r) springs 1 mm.
All tests were conducted with the inner diameter of the spring constrained over a rod.
4.3.2 Polyurethane Rubber – Fatigue

To get an idea of the fatigue behaviour of the PUR(r), two fatigue tests were run on springs with different hardness: Shore 45D and 60D. The dimensions were identical: 1.1 mm inner diameter, 2.2 mm outer diameter, 1.8 mm height. Next to the hardness, some material properties were different [Table 3].

Table 3: Specifications of the two PUR resins as published by the manufacturer (Smooth-On 2016b).

<table>
<thead>
<tr>
<th></th>
<th>Shore 45D</th>
<th>Shore 60D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner Diameter</td>
<td>1.1 mm</td>
<td>1.1 mm</td>
</tr>
<tr>
<td>Outer Diameter</td>
<td>2.2 mm</td>
<td>2.2 mm</td>
</tr>
<tr>
<td>Height</td>
<td>1.8 mm</td>
<td>1.8 mm</td>
</tr>
<tr>
<td>Tensile Strength</td>
<td>10.76 MPa</td>
<td>16.55 MPa</td>
</tr>
<tr>
<td>Elongation at Break</td>
<td>100 %</td>
<td>20 %</td>
</tr>
<tr>
<td>Compression</td>
<td>500 to 700 µm</td>
<td>400 to 600 µm</td>
</tr>
</tbody>
</table>

Shore 45D

The first test is conducted with the Shore 45D spring. First, the spring is compressed to 0.7 mm. Subsequently, a sinusoidal displacement with an amplitude of 0.1 mm is imposed on the spring at 4 Hz. The result is a micromotion starting at 600 µm up to 800 µm compression. It was estimated that the RFP needs to resist 225000 load cycles [Appendix A.3], in this test 250000 were performed. The strain controlled fatigue data is presented in Figure 33.

During the run-in tests, it was seen that the spring could not decompress fast enough to follow the initial input signal of 15 Hz. Therefore, a 4 Hz input was used. Even then the PUR(r) spring had problems returning to its original position. As a result, the DMA was ‘hammering’ on the sample. The spring teared at approximately the 75 thousand cycle. The spring was fully torn over the height across one side.

Shore 60D

The second test is conducted with the Shore 60D spring. First, the spring is compressed to 0.5 mm. Subsequently, a sinusoidal displacement with an amplitude of 0.1 mm is imposed on the spring at 4 Hz. The result is a micromotion starting at 400 µm up to 600 µm compression. A lower displacement is chosen, because the previous test showed that the forces controlled fatigue data is presented in Figure 34.

The estimated 225000 load cycles were achieved. However, some variation in the min and max cycle load, suggest that fatigue is starting to affect the material. Similar to the 45D spring, the 60D spring was not able to follow the 4 Hz input and ‘hammering’ occurred. Contrary to the silicone springs, no wear particles were found during the fatigue testing of the PUR(r) springs. The cause might be twofold. First, the abrasion resistance of PUR(r) is deemed to be very good (Molded Dimensions 2016). Second, the inner diameter of the PUR(r) springs was 1.1 mm and that of the silicone spring 1.0 mm. Therefore, the silicone springs were more directly into contact with the rod, probably causing more abrasion wear. Moreover, this might also facilitate fretting of the spring material between the upper pressure plate and the constraining rod. Coincidentally, the minimal force of both the 45D and the 60D spring both lie around -20 N. The early breakage of the 45D sample, when compared to the 60D sample is at least partly explained by the lower tensile strength. Another cause might be variations in the production. All springs contained some very small air bubbles, but the location of these imperfections might be more problematic for the 45D than for the 60D spring.

What we can conclude is that the PUR(r) is not suitable to be used as a spring material in this situation. The creep is very large and it is very difficult to engineer a spring with the correct specifications due to the large compression set.
4.4 Transversal Expansion of the Rubber Spring

Previous tests showed that the medullary canal can be opened up to 2.3 mm [Section 4.1.2]. Rubber springs bulge outward which might cause problems when implanting the prosthesis if they expand further than allowed by the medullary canal. Both silicones and PUR(r) have a Poisson’s ratio of \( \nu \geq 0.47 \), indicating that they are nearly incompressible and bulge outward very easily. Therefore, these materials could cause problems during prosthesis implantation.

![Figure 35: Compression tool with the opaque white PUR(r) spring inserted on the left](image)

To measure the transversal expansion, a small tool was created that allowed for compression of the spring [Figure 35]. A simple bolt was used to tighten the spring.

The spring that is measured is a 60D PUR(r) spring and has an outer diameter of 2.19 mm, inner diameter of 1.06 mm and height of 1.83 [uncompressed]. After each half turn of the bolt, the height and maximum diameter of the spring are measured with a digital microscope camera.

The results of the tests show that the transversal expansion is approximately \( \frac{2}{3} \) of the compression [Table 4]. The spring immediately started to deform from a straight cylinder to a barrel. This increased the measured transversal expansion. Furthermore, an almost linear relationship between the longitudinal compression and the transversal growth was discovered [Figure 36].

![Figure 36: Plot showing the linear behaviour between the longitudinal compression and transversal growth.](image)

Because the expansional behaviour of the PUR(r) is the same as rubbers with the same dimensions and Poisson’s ratio. The behaviour of this particular spring might be extrapolated to the silicone spring and other rubberlike materials.

<table>
<thead>
<tr>
<th>Microscope Height [mm]</th>
<th>Longitudinal Compression [mm]</th>
<th>Longitudinal Compression [%]</th>
<th>Max. Outer Diameter [mm]</th>
<th>Transversal Growth [%]</th>
<th>Long. Comp. / Trans. Growth</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.83</td>
<td>0.00</td>
<td>0.00%</td>
<td>2.19</td>
<td>0.0%</td>
<td>NaN</td>
</tr>
<tr>
<td>1.71</td>
<td>0.12</td>
<td>6.6%</td>
<td>2.26</td>
<td>3.20%</td>
<td>0.49</td>
</tr>
<tr>
<td>1.61</td>
<td>0.22</td>
<td>12%</td>
<td>2.35</td>
<td>7.31%</td>
<td>0.61</td>
</tr>
<tr>
<td>1.52</td>
<td>0.31</td>
<td>17%</td>
<td>2.44</td>
<td>11.4%</td>
<td>0.67</td>
</tr>
<tr>
<td>1.44</td>
<td>0.39</td>
<td>21%</td>
<td>2.50</td>
<td>14.2%</td>
<td>0.66</td>
</tr>
<tr>
<td>1.39</td>
<td>0.44</td>
<td>24%</td>
<td>2.55</td>
<td>16.4%</td>
<td>0.68</td>
</tr>
<tr>
<td>1.33</td>
<td>0.50</td>
<td>27%</td>
<td>2.62</td>
<td>19.6%</td>
<td>0.72</td>
</tr>
<tr>
<td>1.28</td>
<td>0.55</td>
<td>30%</td>
<td>2.70</td>
<td>23.3%</td>
<td>0.77</td>
</tr>
<tr>
<td>1.21</td>
<td>0.62</td>
<td>34%</td>
<td>2.78</td>
<td>26.9%</td>
<td>0.80</td>
</tr>
</tbody>
</table>
4.5 Press Fitting the Stable Prosthesis in Bone Surrogate

To test the amount of diameter oversize required for press-fit fixation of the stable prosthesis, mock implantations are performed on a bone surrogate. The bone surrogate is shaped analogously to the rat femur to form a medullary canal model (MCM). The stable MCM is drilled open with a single diameter [Figure 37]. This in contrast with the unstable MCM, discussed in the following section.

As bone surrogate material, cotton-filled phenol formaldehyde (CFPF) is chosen because of its high elastic modulus: 7 GPa according to the supplier (Vink Kunststoffen 2015). This is similar to the transversal elastic modulus of cortical bone [10 GPa]. Push-in [implantation] and pull-out [fixation] tests are performed together in one experiment on the Instron E10000 DMA. First, the prosthesis is pushed in the MCM for 20s at 1 mm/s; second, the prosthesis is left idle in the bone for 5s; third, the prosthesis is pulled out the MCM for 20s at 1 mm/s. The push-in/pull-out speed was chosen based on the speed used in similar studies (Seong et al. 2013).

Four different sizes of stable prosthesis are produced out of stainless steel: 2.35, 2.40, 2.45 and 2.50 mm. The technical drawing of the prosthesis can be found in Appendix F. The prostheses are implanted in the bone canal of 2.3 mm. For each implantation, a new MCM is used. Therefore, the axis of the DMA needs to be realigned in between tests.

![Figure 37: Medullary canal model with a straight canal, prepared to fit an implant of the stable design](image)

The results of the tests are shown in Figure 38. Oddly enough, the highest force was measured with the smallest prosthesis, 600 N [Figure 38A]. The 2.40, 2.45 and 2.50 mm prostheses were probably slightly misaligned: after the initial negative increase in force at the start of the test, the curves return to -75 N. No breakage occurred during push-in or pull-out, which was unexpected. It appears that we are mostly measuring the friction between the prosthesis and the CFPF. Unfortunately, the results do not disclose more information.
4.6 Micromotion of the Unstable Prosthesis in Bone Surrogate

We want to assess the amount of micromotion of the unstable design of the prosthesis. Therefore, detailed technical drawings are made of the rubber spring concept from Section 3.4.2. The design fitted a universal testing machine (UTM) and is produced at the central workshop of the TU Delft. The full set of technical drawings can be found in Appendix F.

The concept consists of an unstable top part and a stable bottom part. The top part consists of a cylinder in which a hammer is fixated through a press-fit. The hammer runs through the spring and forms the connection between the top and bottom parts of the prosthesis. The bottom cap is fixated into the bottom cylinder with a press-fit. In addition, the hammer runs into the bottom cap after the top part is displaced 200 µm downwards, limiting the micromotion. The top and bottom part are separated by a PUR(r) spring to make the top part return to its original position.

The unstable prostheses are implanted in the unstable MCM (Figure 40). The unstable MCM is drilled open with a 2.3 mm diameter to a depth of 2.0 cm. Then the canal is opened with a 2.5 mm drill to a depth of 1.5 cm. Because of this two-stepped diameter, the unstable design can be fixated in the bottom part of the canal with a press-fit, while it is able to move in the top part. The unstable MCM is produced from CFPF.

The test setup is shown in Figure 41. The tests are performed on an Instron 4400R UTM. In contrast to the earlier used DMA, this machine is not suited for measuring fast displacement. At the start of the test, the upper pressure plate and the implant are placed next to each other without contact. The pressure plate is moved down at 3.33 µm per second (200 µm per minute). When a force larger than 1 N is registered, the actual test will start.

The actual tests consist of a four-step cycle: (1) the compression phase, in which the unstable RFP is linearly compressed 200 µm in 60s; (2) a 10s-dwelling period at 200 µm compression; (3) the decompression phase, in which the unstable RFP is linearly decompressed 200 µm in 60s; (4) a dwelling period of 10s, before the next cycle starts.

Before the actual test, one cycle was run to check the correct position of the RFP. During the actual test, the cycle is repeated three times for each unstable RFP. The results are found in Figure 42 to 44 on the following two pages.
What can be seen in the first three force-displacement plots is an initial plateau in which we believe the spring is being compressing. The length of this plateau differed per implant. The onset of the force is delayed for the second cycle. This is probably caused by the compression set of the PUR(r) spring. For the third cycle the onset is delayed even further.

After the plateau, a steep increase in the force indicates the unstable RFP is fully compressed and the UTM is compressing the CFPF instead of the rubber spring. The micromotion that is measured is approximately 75, 90 and 25 µm for the 2.35, 2.40 and 2.45 mm RFP respectively.
What makes the data more difficult to interpret, is the fact that the spring will bulge outward to a diameter larger than 2.50 mm [Section 4.4]. After bulging out to 2.50 mm, the PUR(r) spring comes into contact with the wall of the MCM. Because the PUR(r) is nearly incompressible, this could cause an increase in stiffness which can partially explain why the 200 µm of motion is not achieved.

What must be noted is that the 2.50 mm RFP has the same size as the upper diameter in the MCM. It appears that the friction of the canal is obstructing our ability to measure the micromotion plateau. After the first cycle, the RFP is probably fully compressed and cannot return to its original position, due to the friction in the canal. This hypothesis is however contradicted by the fact that a run-in test was performed before the actual test. This run-in test should have already locked the RFP in its compressed state.
5 Discussion

The goal of this thesis was to develop a prosthesis for rats that can induce aseptic loosening. This is translated to proving the feasibility of inducing micromotion in the rat femur. During the experiments, the production of the prosthesis and the implementation of results, questions arose that are discussed in the following sections.

5.1 Properties of the Rubber Springs

The largest part of the experiments revolved around testing the rubber springs. The tested elastomers were shown to be unsuitable for allowing micromotion in the prosthesis. The silicone rubber spring’s stiffness was too low, barely able to withstand 5 N at 1 mm compression. Moreover, the flexibility of the silicone was increased by the barrel shaped deformation mode, resulting in forces that were ten times lower than estimated. PUR(r) was also disqualified for use as a miniature spring, due to the high creep and large compression set. As a result, the PUR(r) spring was not able to follow the 4 Hz sinusoidal input of the DMA.

For this application, the rubber spring material should possess:
- High compressive modulus
- High fatigue strength
- Low compression set
- Low Poisson’s ratio

Harder silicone or polyurethane rubbers might display mechanical properties that are more suited than the materials that were tested in this study. Additionally, we want to restate that the hardness wasn’t measured per production batch. This makes it difficult to extrapolate the data to other types of silicone rubbers.

5.2 Force-Displacement Validity

The forces on the silicone springs were difficult to measure with the test setup due to the fact that the forces were very small for the sensor range. Some noise was measured, because we were measuring small forces relative to the 1 kN load cell. However, no problems were noticed except for one oscillational problem when testing in the torque.

5.3 Fatigue Validity

The main problem with the fatigue testing was the alignment of the upper pressure plate with respect to the lower pressure plate. When misaligned, the frictional forces quickly rose to 1 N while using a control signal [an imposed sinusoidal displacement]. By installing the pressure plates with utmost care, we believe this was prevented.

5.4 The Medullary Canal Model

The conceived MCM is classified to be unrealistic for the cadaverous rat femur, it was difficult to fit a prosthesis with the same diameter as the drill diameter, while the 2.30 mm sized MCM could fit a prosthesis of 2.50 mm. This indicates that the CFPF is more compliant than cortical bone.

6 Recommendations

First, a set-up for implantation of the RFP is proposed. From this a problem with the micromotion of the RFP was revealed. To solve this problem, a proposal for a change in the design is made [Figure 47].

6.1 Implantation

The standard surgical approach in humans is a medial parapatellar arthrotomy (Tremoleda et al. 2011; LROI 2015): the skin is incised across the patella from the front side; Then the arthrotomy is performed by making a medial cut starting from 4 cm proximal of the patella down to the tibial tubercle [Figure 46].

![Figure 46: Incision of the medial parapatellar arthrotomy. Copied from Luna et al. 2010](image)

The knee joint of the rat is discussed extensively in an article from Hildebrand et al. 1991. The anterior cruciate ligament [ACL] and posterior cruciate ligament [PCL] have the same shape and insertion points in rats as in humans. Even though the small dimensions make it very difficult to create a PCL-retaining RFP, this might be interesting, because “large alterations” to the running abilities of the
rat were reported after implantation of a knee hemiprosthesis. (Personal correspondence with an author of a previous study on rat hemiprosthesis).

The reported biomechanical problems make it very important to measure the mobility of the rats pre- and post-operation. Large alterations to the gait can cause unnecessary harm to the rats and alter the structure of the bone due to a different load distribution after implantation. Finally, it is necessary to physically restrict the drill depth, preventing femoral fractures during implantation.

6.2 Design of the Prosthesis

We propose three additions to the unstable design. First, the current design of the prosthesis does not include an articulating surface. However, adding metallic condyles to the implant causes problems with the RFP’s micromotion, because the condyles cause the top part of the implant to abut on the cortical bone of the rat. Therefore, it is suggested to place a rubber spring in between the condyles and the cortical bone [Figure 47].

![Figure 47: Lateral view of the design proposal. A double rubber spring allows for micromotion in the rat femur](image)

Second, the bottom part of the RFP that is press-fitted in the bone, needs to be protected against torsional forces. Therefore, it is suggested to add flanges on the medial and lateral side of the bottom part.

Third, the designed micromotion of 200 µm is currently not achieved in vitro. The measurements are partly off, but more measurements of the isolated unstable RFP should demonstrate if this is a problem of the design or if the problem occurs due to the confinement of the spring within the medullary canal.

6.3 Perceived Production

At the onset of this research it was believed that rat specific prosthesis might be needed. Current experiments show that implant with standard sizes should properly fit into the medullary canal of a properly selected group of rats. The main problem lies in recreating the articular surfaces for the RFP. On this small scale, dimensional errors might easily lead to biomechanical problems in the rat’s knee joint. It is recommended to measure the variations of the knee’s condyles in the available µCT images to get an approximation of the condyles’ dimensions and variation of these dimensions. If necessary, µCT images can be attained before surgery and the articulating surface can be printed in a suitable alloy. Postprocessing will be necessary to bring down the roughness of the printed articulating surface.

7 Conclusion

The goal of this research was to develop a prosthesis for rats that can induce aseptic loosening. In this study, the first steps toward such an RFP have been made and it appears feasible that a prosthesis with fixed micromotion works in-vivo. However, an extra design iteration is required to solve the problems with the micromotion before any in-vivo trials can start. It is therefore recommended to follow-up on this research.
8 Bibliography


Wehner, T. et al., 2010. Internal forces and moments in the femur of the rat during gait. *Journal of
Biomechanics, 43(13), pp.2473–2479.
Appendix A  Test Protocols

Appendix A.1  Biolab Protocol 1 – Opening of the Medullary Canal in Rat Femoral Bone

1. Introduction

For research into aseptic loosening a femoral rat implant is being developed. Both a stable and an unstable design are to be implanted into the femur of the rat. The goal of this specific experiment is to find out how to open the medullary canal of the rat femur. The proposed methods are through hydraulic pressure or mechanical drilling. The second goal is to find out if it is easier to open up the medullary canal from the side of the hip joint or the side of the knee joint.

2. Project Execution

2.1 Equipment

- Biosafety cabinet [BSC]
- 0,1 mm photo etched saw blades
- 0,15 mm photo etched saw blades
- Hobby knife holder
- Plastic cutting board
- Cutting gloves
- Pin vise
- Basic Drill Set: 1, 1.5, 2.0, 2.5 and 3 mm Ø
- Monoject 412 Irrigation syringe
- Phosphate buffered Saline (PBS)

2.2 Specimens

- Rat femur
  - The adult, male, Wistar rats are supplied by Harlan Laboratories to the UMC Utrecht.
  - The specimens are harvested as a by-product.
  - All femurs originate from a pathogen free herd. The batch is accompanied by this statement from the supplier (UMC Utrecht).
  - Specimens are free of soft tissue and kept dry-frozen in the freezer at the UMC Utrecht.

3. Procedure

3.1 Specimen preparation

Before the test, the femurs will be removed from the freezer and thawed in PBS in the refrigerator for 24 hours.
3.2 Trials

All trials will be performed in the BSC. The BSC will be cleaned with a 70% ethanol solution before and after each test run. Two femora will be sawed open from the hip joint side with photo-etched saw blades. Another two femora will be sawed open from the knee joint side with photo-etched saw blades. This will be done on the cutting board, while using the cutting gloves. The 0.1 mm saw blades will be used; the 0.15 mm saw blades are for backup. The saw blades are rinsed in a jar of water to clean out the teeth of the saw.

One of the two medullary canals will be opened using the Monoject 412 irrigation syringe. Because the waterjet might cause aerosols formation, this will be done in a water bath to prevent the formation of aerosols. One of the medullary canals will be opened by hand drilling, using the pin vise. This is done while wearing the cutting gloves.

3.3 Disinfecting

After the experiment, the cutting board, saw blades, pin vise and drills will be autoclaved according to the ML-1 BioLab Handbook (Appendix 3.2). The hobby knife holder and the syringe will be sterilized with a 70% ethanol solution. The cutting gloves will be autoclaved if possible, otherwise they are disposed as clinical waste and incinerated. The water that is used to rinse the saw blades and the water from opening the medullary canal is collected. The collected water is disinfected using chlorine tablets, following the instructions of the supplier regarding soaking time and concentration. Each day, after the experiments, surfaces will be disinfected with a 70% ethanol solution and cleaned with water and soap afterwards.

3.4 Disposal

After completion of the tests, the specimens will be placed in a waste bag and kept in a -28°C freezer until it is disposed as clinical waste and incinerated.
Appendix A.2  Biolab Protocol 2 – Micromotion of a Femoral Implant in the Cadaverous Rat Femur

1. Introduction

Aseptic loosening of implants is a large problem in the longevity of total joint arthroplasty. To recreate the membrane around the loosened implant, we want to design an in vivo model in the rat by using a rat femoral implant. Both a stable and an unstable implant are to be designed.

The goal of this specific experiment is twofold. First, we want to see if the stable design [SD] of the implant can be fixated with a micromotion of less than 40 µm. Secondly, we want to test if the unstable design [UD] of the implant can be fixated with a micromotion of 200±50 µm. The proposed method is by implanting the two designs in cadaverous rat femora and verifying the micromotion in a Dynamic Mechanical Analyser.

2. Project Execution

2.1 Equipment

Implantation

- **Tools:**
  - Biosafety cabinet
  - Hobby knife holder
  - Plastic cutting board
  - Pin vice
  - Drill, 2.2 mm Ø
- **Disposables:**
  - Phosphate buffered saline [PBS]
  - 0,1 mm photo etched saw blades
  - Cutting gloves
  - Cold cure epoxy
  - BenchKote
  - Stable design implants, 3D printed Ti-6Al-4V
  - Unstable design implant, 3D printed Ti-6Al-4V

Mechanical Analysis

- Dynamic Mechanical Analyser [DMA]
  - The DMA that is used is the Instron E10000
  - The Dynamic Mechanical Analyser is located right next to ML1 Lab 34-J-0-440 Building 34, Mekelweg 2, 2628 CD, Delft
- PET Cylinder
  - The analyser is equipped with a PET cylinder, which is placed around the specimen and grips to contain any splinters formed during the trials. PET can be cleaned with a 70% alcohol solution
- Grip
- Pressure Plate
  - The pressure plate is made out of stainless steel so it can be autoclaved.

2.2 Specimens

- **Rat femur**
  - The adult, male, Wistar rats are supplied by Harlan Laboratories to the UMC Utrecht.
  - The specimens are harvested as a by-product.
  - All femurs originate from a pathogen free herd. The batch is accompanied by this statement from the supplier (UMC Utrecht).
  - Specimens are free of soft tissue and kept dry-frozen in the freezer at ML1 Lab 34-J-0-440 Building 34, Mekelweg 2, 2628 CD, Delft.
3. Procedure

3.1 Specimen Preparation and Trials

24 hours before each experiment, the femora are put in PBS and transferred to the refrigerator to thaw. Ten femora are available: five right and five left.

- One left and one right femora will be used as control group [CG] – Experiment 1
- Two left and two right femora will be implanted with the stable design [SD] – Experiment 2
- Two left and two right femora will be implanted with the unstable design [UD] – Experiment 3

Prior to testing the surfaces of the Dynamic Mechanical Analyser will be covered with plastic foil and a working surface will be created lined with BenchKote.

Experiment 1 – The Control Group

In the biosafety cabinet [BSC], the four femora will be dried of with paper. Thereafter the superior and posterior side of the femur will be cast in epoxy resin (Figure 48). After casting, the femur-epoxy complexes are removed from the BSC and put back in the fridge to let the epoxy cure for one day.

After hardening, the epoxy-implant complex will be transferred from the fridge to the DMA, right next to ML1 Lab 34-J-0-440. Under continuous supervision the stress strain curve will be measured under quasi-static and dynamic loads (1 Hz, 2 Hz, 4 Hz).

Experiment 2 – The Stable Design

In the biosafety cabinet [BSC], four femora will be dried of with paper. The superior side of the femur will be cast in epoxy resin. After casting, the femur-epoxy complexes are removed from the BSC and put back in the fridge to let the epoxy cure for one day.

After hardening, the femur-epoxy complexes are returned to the BSC. They are implanted with prostheses on the posterior side of the femur (Figure 49). These prostheses are of the stable design.

The prostheses are implanted by:
- Cutting open the femoral condyles using the saw blades.
  This is done while wearing cutting free gloves
- Drilling open the medullary canal, by using the pin vice and the 2.2 mm drill
- Press fitting the 3D printed Ti-6Al-4V implant in the femur

After implantation, the epoxy-bone-implant complex will be transferred from the BSC to the DMA, right next to ML1 Lab 34-J-0-440. The epoxy will allow for the bones to be clamped in the DMA. The lower part of the prosthesis is designed with a flat surface on which loads can be applied. Under continuous supervision the stress strain curve will be measured under quasi-static and dynamic loads (1 Hz, 2 Hz, 4 Hz).
Experiment 3 – The Unstable Design

In the biosafety cabinet (BSC), four femora will be dried of with paper. The superior side of the femur will be cast in epoxy resin. After casting, the femur-epoxy complexes are removed from the BSC and put back in the fridge to let the epoxy cure for one day.

After hardening, the femur-epoxy complexes are returned to the BSC. They are implanted with prostheses on the posterior side of the femur (Figure 49). These prostheses are of the unstable design. The prostheses are implanted by:

- Cutting open the femoral condyles using the saw blades.
- This is done while wearing cutting free gloves
- Drilling open the medullary canal, by using the pin vice and the 2.2 mm drill
- Press fitting the 3D printed Ti-6Al-4V implant in the femur

After implantation, the epoxy-bone-implant complex will be transferred from the BSC to the DMA, right next to ML1 Lab 34-J-O-440. The epoxy will allow for the bones to be clamped in the DMA. The lower part of the prosthesis is designed with a flat surface on which loads can be applied. Under continuous supervision the stress strain curve will be measured under quasi-static and dynamic loads (1 Hz, 2 Hz, 4 Hz).

3.2 Disinfecting

After the experiment, the:

- Implant
- Cutting board
- Saw blades
- Pin vice and drill

will be autoclaved according to the ML-1 BioLab Handbook (Appendix 3.2).
The cutting gloves will be autoclaved if possible, otherwise they are disposed as clinical waste and incinerated.

After the experiment, the:
- Grips of the DMA
- Hobby knife holder
- PET cylinder
will be sterilized with a 70% ethanol solution.

Each day, after the experiments, surfaces will be disinfected with a 70% ethanol solution and subsequently cleaned with water and soap.

3.3 Disposal

After completion of the experiments, the rat tissues, plastic foil, BenchKote and gloves will be placed in a waste bag and kept in a -28°C freezer until they are disposed as clinical waste and incinerated.
Appendix A.3 Measuring the Elastic Modulus and the Fatigue Behaviour of the Silicone Spring

1. Spring Test Setup

We want to design the miniature implant with a constrained micromotion. For this it is required to know the force-displacement relationship of the rubber spring [Figure 51]. Next to a compression test, the springs will be subjected to fatigue using a Dynamic Mechanical Analyser. Both tests for the silicone rubber spring were conducted on an Instron E10000 with a 1 kN load cell. After testing the silicone rubber, an error in the software of Instron caused a physical defect in the load cell. Therefore, the forces of the PUR(r) springs were measured using a 10 kN load cell. This introduced larger sensor noise, but this was less significant in the PUR(r) tests than in the silicone rubber tests, because the forces were much larger in the PUR(r) measurements.

Figure 51: Approximate measurements [in mm] of the rubber spring

A specialized tool is produced to test the rubber spring. Identical to the unstable prosthesis, the springs will be positioned over a rod of 1 mm.

Figure 52: The specialized tool, used to mimic the designed implant

1.1 Compression Tests

The rubber springs are ≈2 mm thick. In vivo, the implant will endure forces of ≈20 N. At this load, we want a compression of 200 µm. However, we also require a pretension of 10N. Therefore, the spring must resist a load of 10 N at -200 µm and a load of 20 N at -400 µm.

To obtain the full force-displacement curve, a compression of 1 mm is imposed on the spring. The compression speed is 0.4 mm/s. The decompression speed is 0.1 mm/s.
1.2 Fatigue Tests

To determine if the rubber spring is appropriate, a cyclic displacement controlled test is run to obtain the characteristic. Displacement control was chosen, because the current design of the femoral implant limits the displacement of the spring in both direction. Unless stated otherwise the fatigue tests were performed by applying 200 µm of pretension and then applying a sinusoidal movement up to 400 µm in total.

Number of Fatigue Cycles

The prosthesis will be implanted in rats, that have a maximum stride length of approximately 15 cm (Beckett et al. 2012). Because this is the maximum stride length, an average length of 50% was assumed: 7.5 cm Normal walking distance of the Wistar Rats is approximately 6.2 m/h (Schwarzberg et al. 1989).

Assuming that the rats sleep 80% during the daytime and 30% during the night-time (Antle & Mistlberger 2005), the rats are active for:

\[12 \text{ hours} \times 0.2 + 12 \text{ hours} \times 0.7 = 10.8 \text{ hours/day}\]

This results in:

\[6.2 \text{ m/h} \times 10.8 \text{ hours/day} / 0.075 \text{ m} = 900 \text{ steps/leg/day}\]

During a 6-month implantation period a total of:

\[900 \text{ steps/day} \times 6 \text{ months} \times 30 \text{ days} = 162,000 \text{ steps}\]

Testing the spring for 1,000,000 repetitions should therefore be enough to predict the fatigue behaviour of the rubber springs in vivo. At 15 Hz, this will take approximately 19 hours.
Appendix B  Expanded Results for the Material Tests

The springs were measured under a digital microscope. For the outer diameter and the hole diameter, two measurements were taken perpendicular to each other and the averaged value is reported.

Appendix A.1  Size Measurements for the Silicone Springs

<table>
<thead>
<tr>
<th>Sample #</th>
<th>Hardness [Shore A]</th>
<th>Caliper Diameter [mm]</th>
<th>Microscope Diameter [mm]</th>
<th>Microscope Hole Diameter [mm]</th>
<th>Caliper Height [mm]</th>
<th>DMA Height [mm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30</td>
<td>1.81</td>
<td>NaN</td>
<td>NaN</td>
<td>1.82</td>
<td>1.72</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>2.16</td>
<td>2.16</td>
<td>NaN</td>
<td>1.80</td>
<td>1.85</td>
</tr>
<tr>
<td>3</td>
<td>30</td>
<td>2.19</td>
<td>2.20</td>
<td>NaN</td>
<td>1.95</td>
<td>1.96</td>
</tr>
<tr>
<td>4</td>
<td>60</td>
<td>1.79</td>
<td>1.76</td>
<td>0.98</td>
<td>1.86</td>
<td>1.96</td>
</tr>
<tr>
<td>5</td>
<td>60</td>
<td>2.00</td>
<td>1.97</td>
<td>0.99</td>
<td>1.77</td>
<td>1.76</td>
</tr>
<tr>
<td>6</td>
<td>60</td>
<td>2.20</td>
<td>2.17</td>
<td>1.01</td>
<td>1.76</td>
<td>1.71</td>
</tr>
<tr>
<td>7</td>
<td>70</td>
<td>1.93</td>
<td>1.97</td>
<td>0.98</td>
<td>1.72</td>
<td>1.74</td>
</tr>
<tr>
<td>8</td>
<td>70</td>
<td>2.09</td>
<td>2.17</td>
<td>0.98</td>
<td>1.74</td>
<td>1.67</td>
</tr>
<tr>
<td>9</td>
<td>70</td>
<td>2.17</td>
<td>2.19</td>
<td>0.99</td>
<td>1.77</td>
<td>1.76</td>
</tr>
</tbody>
</table>

Appendix A.2  Size Measurements for the PUR(r) Springs

<table>
<thead>
<tr>
<th>Sample #</th>
<th>Hardness [Shore D]</th>
<th>Production Batch</th>
<th>Microscope Diameter [mm]</th>
<th>Microscope Hole Dia[m]</th>
<th>Microscope Height [mm]</th>
<th>DMA Height [mm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>45</td>
<td>1</td>
<td>2.17</td>
<td>1.07</td>
<td>1.65</td>
<td>1.60</td>
</tr>
<tr>
<td>12</td>
<td>45</td>
<td>1</td>
<td>2.12</td>
<td>1.05</td>
<td>1.77</td>
<td>1.78</td>
</tr>
<tr>
<td>13</td>
<td>45</td>
<td>1</td>
<td>2.15</td>
<td>1.05</td>
<td>2.09</td>
<td>2.12</td>
</tr>
<tr>
<td>14</td>
<td>60</td>
<td>2</td>
<td>2.25</td>
<td>1.07</td>
<td>1.63</td>
<td>1.61</td>
</tr>
<tr>
<td>15</td>
<td>60</td>
<td>2</td>
<td>2.13</td>
<td>1.06</td>
<td>1.83</td>
<td>1.84</td>
</tr>
<tr>
<td>16</td>
<td>60</td>
<td>2</td>
<td>2.16</td>
<td>1.06</td>
<td>2.02</td>
<td>2.03</td>
</tr>
<tr>
<td>17</td>
<td>45</td>
<td>1</td>
<td>2.11</td>
<td>1.05</td>
<td>1.83</td>
<td>1.83</td>
</tr>
<tr>
<td>18</td>
<td>60</td>
<td>3</td>
<td>2.13</td>
<td>1.07</td>
<td>1.87</td>
<td>1.88</td>
</tr>
</tbody>
</table>
Appendix A.3 Silicone Rubber Compression Tests

Sample 2

Sample02.1 Compression with Rod (n = 4)

Sample02.2 Compression without Rod (n = 2) Before rotational oscillation

Sample02.3 Compression without Rod (n = 5) After rotational oscillation

Sample02.5 Compression after Fatigue without rod (n=5)
Sample 3

Sample 03.1 Compression with Rod (n=4)

Sample 04.1 Compression without Rod (n=4)
Sample 04.3 Compression after Fatigue without rod (n=5)
Sample 04.4 Compression after Fatigue without rod 2 (n=5)
Sample 9.1 Compression without Rod (n=5)

Sample 9.3 Compression after Fatigue without Rod (n=5)
Appendix A.4  Silicone Rubber Fatigue Tests
Appendix A.5  Polyurethane Resin Compression Tests

Sample 11 Compression with Rod (n=5) (Height = 1.65 mm)

Sample 12 Compression with Rod (n=5) (Height = 1.77 mm)

Sample 13 Compression with Rod (n=5) (Height = 2.09 mm)

Sample 14 Compression with Rod (n=5) (Height = 1.63 mm)

Sample 15 Compression with Rod (n=5) (Height = 1.83 mm)

Sample 16 Compression with Rod (n=5) (Height = 2.32 mm)
Figure 53: Test setup in the biosafety cabinet

Figure 54: Medullary canal opened with a 2.5 mm drill (shown in the pin vice) [Inferior approach]
Figure 55: Medullary canal opened with a 2.0 mm drill
[Superior approach after osteotomy above the smaller trochanter]

Figure 56: Medullary canal opened with water pressure. A 2.0 mm drill fitted the ready-made hole
[Inferior approach]
Figure 57: Medullary canal opened with water pressure. The small entrance at the femoral is shown. [Superior approach]

Figure 58: Medullary canal opened with water pressure. The cut through the shaft revealed that the medullary canal was not completely clean. [Superior approach]
Appendix D  Selection of Bone from Multiple µCT Stacks

Micro CT images of the bones were obtained, however, it turned out that the rat implants do not need to be personalized. The µCT images are used for visualisation only.

Install Fiji

Import the CT Stack. Do this by selecting the menu “File” -> “Import” -> “Image Sequence…”

Make sure that the menu looks the same as below and click “OK”

After the images have been imported we can convert the whole stack to 8-bit images. Note that this is different from selecting “Convert to 8-bit Grayscale” in the previous menu. It is needed to convert the bit depth of the images, because the Pairwise Image Stitching plugin is not able to correctly work with 16 bit stacks.

Convert the images by selecting the menu “Image” -> “Type” -> “8-bit”

Now you are ready to run the pairwise stitching plugin. Open it by selecting the menu “Plugins” -> “Stitching” -> “Pairwise stitching”.

Enter the menu “Image” -> “Adjust” -> “Brightness/Contrast” menu (hotkey shift + c) and “set” the minimum displayed value to 100 for the 8-bit images. Apply the LUT to the whole stack

Enter the menu “Image” -> “Adjust” -> Auto Local Threshold -> Set the radius to 20 -> Phansalkar showed a little more detail than Sauvola, but both gave quite similar and very good results. Finally, I choose the Phansalkar method.
Appendix E  Cortical Thickness Measurement
Appendix F  Technical Drawings

[The technical drawings are on the following pages]